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Election Time — Vote for national STC 2nd Vice Prez

(Continued on page 6)

Andrea L. Ames, STC Region 8 Director-
Sponsor (1998-2001)

In response to inquiries and requests from
several chapters’ leaders for an article about
my candidacy for STC Second Vice Presi-
dent, I’d like to share my thoughts with you
about our future—yours, mine, STC’s, and
the future of the technical communication
industry as a whole—and why I want to
continue to serve you on the STC Board of
Directors for the next four years.

As you might know, the candidate elected
to the office of Second Vice President will
serve for one year in that position and will

Ames envisions tech
writers as more than
just document makers

 
Editor’s Note: Candidates Ames and
Teich are running for one of several
STC offices in the upcoming na-
tional elections. STC members
should have recently received infor-
mation about the election in the
mail. STC members must vote by
March 31.

Candidate Teich says we can “design, draw, paint
and frame our own futures”

then serve one year each as First Vice Presi-
dent, President, and Immediate Past Presi-
dent.

This is an important vote, and I hope this
article enables you to make an informed
decision when you cast your ballot.

If you have any questions about me or my
candidacy, feel free to contact me at
andrea@verbal-imagery.com. You can also

visit my Web site (www.verbal-imagery.com)
for postings of recent chapter-meeting pre-
sentations and other information.

The VisionThe VisionThe VisionThe VisionThe Vision

If elected, I will work for the next four years
to raise our strategic value—both as indi-
viduals and as an industry—to the organi-
zations for which we work.

My vision for the industry is one in which:

* Our main goal is to ensure users’ suc-
cess—NOT to write documentation

* We design and develop information to
enable users to use products—NOT to fill
in for the deficiencies in product design

In other words, we will no longer define
ourselves by the information products

(Continued on page 7)

Thea Teich, Senior Member, Southwest-
ern Ohio Chapter

Hello. Please let me introduce myself. I’m
Thea Teich, and I’m running for 2nd vice
president of STC. That means a four-year
commitment to Society leadership, which is
something I look forward to, should I win
your votes.

Just a quick overview of my background: I
was brought up in northern New Jersey.
For those of you in the area, my high school

overlooked the back side of the Statue of
Liberty. Really.

I left NJ to attend the University of Michi-
gan. Then I took a master’s degree at the
University of Wisconsin in Madison. I spent
several summers as a park ranger in Okla-
homa during this period. Yes, really.

I continued to spend my young adulthood
on Big Ten campuses by working for the
Ohio State University School of Natural
Resources for three years. Then, I became
the environmental education coordinator
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Blue PencilBlue PencilBlue PencilBlue PencilBlue Pencil

Blue Pencil is the official newsletter of the Society for Technical
Communication (STC), Pittsburgh chapter. It is published monthly
from September through June by the Pittsburgh chapter to inform
and promote communication within the chapter and the Society.
Material contained in this publication may be reprinted by other
STC chapters, provided credit is given. Please send a copy of the
reprint to the editor. Readers are invited to submit ads, short
articles, news, reviews, and other material of interest to technical
communicators by the 10th of the month prior to publication to:

Christina Downs, Blue Pencil Managing Editor
Email: stcdowns@aol.com, Phone: 724-532-3669
Or: Jon Szish, Blue Pencil Editor
Email: JonSzish@aol.com

=  Experts on tools such as FrameMaker,
RoboHELP, ForeHelp, and WebWorks
Publisher.
=  Experts on technologies such as XML,
CSS, distance learning, web-based
training, online help.
=  Experts on processes such as struc-
tured writing, indexing for online informa-
tion, preparing information for global
markets.

For more information, email Mike Doyle
(mdoyle@pubsnet.com), call 978-649-
8555, or visit http://www.doctrain.com/
com

STSTSTSTSTC members: Deduct your STC members: Deduct your STC members: Deduct your STC members: Deduct your STC members: Deduct your STC duesC duesC duesC duesC dues
from taxes!!!from taxes!!!from taxes!!!from taxes!!!from taxes!!!
Editor’s Note: This article originally ap-
peared in Tieline, which is STC’s officer
newsletter.

STC members who pay taxes in the United
States can claim dues as a tax deduction in
several ways.

Charitable ExpenseCharitable ExpenseCharitable ExpenseCharitable ExpenseCharitable Expense

All STC members who pay taxes in the
United States can deduct at least a portion
of their STC dues if they claim this portion
as a charitable donation. IRS publication
526 (rev. 1998) defines this option:

You may be able to deduct membership
fees or dues you pay to a qualified organi-
zation. However, you can deduct only the
amount that is more than the value of the
benefits you receive.

As a 501(c)(3) organization, STC is a quali-
fied organization. The only determination
that you need to make is the amount that is
more than the value of the benefits you
receive.

STC’s tangible benefits can be estimated
at $30 ($15 for the Society’s quarterly jour-
nal, Technical Communication, and $15 for
the magazine, Intercom).

The difference between the cost of mem-
bership ($110) and tangible benefits ($30)

is $80, and you may claim that amount as a
charitable contribution.

Business ExpenseBusiness ExpenseBusiness ExpenseBusiness ExpenseBusiness Expense

Employees and self-employed consultants
may claim the full amount of dues as a busi-
ness expense.

Miscellaneous ExpenseMiscellaneous ExpenseMiscellaneous ExpenseMiscellaneous ExpenseMiscellaneous Expense

Those who do not fall into the categories
defined above may claim the amount of the
dues as a miscellaneous deduction. (For
miscellaneous deductions that can affect
your taxes, the total amount of miscella-
neous deductions must exceed 2 percent
of your adjusted gross income.)

If dues are deducted as a charitable ex-
pense, business expense, or miscellaneous
expense, they must be deducted from the
tax return filed for the year in which they
were paid. In other words, dues paid in 2000
can be deducted only on 2000 tax returns.
If you have any questions, contact your
local IRS representative or an accountant.

MoneyMoneyMoneyMoneyMoney, Not T, Not T, Not T, Not T, Not Timeimeimeimeime

The STC office has received a question
concerning the deduction of time or ser-
vices donated to STC. Please be aware that,
while dues, contributions, and out-of-
pocket expenses may be deducted, ser-
vices cannot.

The Documentation & Training 2001
Conference is planned for April 9-10 at
Boston University’s Corporate Education
Center, Tyngsboro, Massachusetts.

The keynote speakers will be Robert E.
Horn (inventor of information mapping
methodology, author of Visual Language,
visiting scholar at Stanford) and Dr.
Deborah J. Mayhew (usability pioneer,
author of several usability books
including The Usability Engineering
Lifecycle).

There will be:
=  More than 40 sessions, including 16
hands-on MiniLabs.

Upcoming documentation conferenceUpcoming documentation conferenceUpcoming documentation conferenceUpcoming documentation conferenceUpcoming documentation conference

�

�
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WWWWWord Smith: Tord Smith: Tord Smith: Tord Smith: Tord Smith: Tooling around with templatesooling around with templatesooling around with templatesooling around with templatesooling around with templates
By Bob Mohr

Templates are one of the more powerful
weapons in Word’s arsenal. Many sample
templates are installed with Word. Some of
these can be used as is, but most are in-
tended to be customized and saved as new
templates. Whenever possible, base new
documents on existing templates. Doing so
will make you more productive, since you
won’t be starting from scratch all the time,
and it will make your documents more con-
sistent.

TTTTTemplates as Containersemplates as Containersemplates as Containersemplates as Containersemplates as Containers

Templates can also be used, in part, as con-
tainers for styles, macros, toolbars, and
AutoText entries. Suppose you’re working
on a document, and you want to use the
same Note Heading style that you pains-
takingly created in a template I’ll call Utili-
ties. Rather than repeat all of the formatting
steps to recreate the style, just copy it from
the Utilities template.

Here’s how:

1. Choose Tools > Templates and Add-
ins.

2. Click the Organizer button. The Orga-
nizer dialog box is displayed.

Notice the document elements, represented
by tabs, that are available for copying. Also
notice the current document is listed on the
left side and Normal.dot is listed on the right
side. This is the default condition for the
Organizer box. Since the document contain-
ing the Note Heading style is not
Normal.dot, it must be replaced here with
the Utilities template.

3. Click the Close File button under
Normal.dot. The Close File button
toggles to an Open File button.

4. Click the Open File button.

5. Navigate to the appropriate directory,
and select the Utilities template. When
finished, you’re returned to the Orga-
nizer box. This time, Normal.dot has
been replaced with Utilities.dot.

6. Scroll down the list of styles, and se-
lect Note Heading.

7. Click the <<Copy button. The style is
now part of the current document. You
can copy as many styles as necessary.
(Use Ctrl+click to select and copy mul-
tiple styles at once.)

8. Click Close to return to the active docu-
ment.

You can also “borrow” styles from a tem-
plate without actually copying them into
your document.

It’s done by attaching a template of your
choice to the currently open document.
Here’s how:

1. Choose Tools > Templates and Add-
ins.

2. Click Attach and select the appropri-
ate template file.

3. Click Open.

4. Click the check box to have Word Au-
tomatically update document styles.
This option causes the styles in the
document to be replaced with styles of
the same name from the attached tem-
plate.

5. Click OK.

This method is convenient, but it has a dis-
advantage: In order for the styles to work
properly, the assigned template must be
available each time the document is opened.
Consequently, if you send a document that
relies on an attached template to a friend,
you must also send the applicable template.

Sharing TSharing TSharing TSharing TSharing Templatesemplatesemplatesemplatesemplates

Templates are powerful allies in the war
against inconsistency. If you share Word
documents, sooner or later you’ll run into
situations where documents that are sup-
posed to have the same “look and feel” are
not the same. Sharing a single template for
particular types of documents will help al-
leviate the inconsistencies.

For example, suppose you’re involved with
several contributing authors on a proposal
effort. Each contributor is responsible for
drafting a section. Your job is to pull the
sections together into a single document.
Imagine if the Body style is Times Roman
12pt in one document, Arial 10pt in another
document, and in another document, all text
is a collection of the Normal style reformat-
ted manually to distinguish between body
text and headings. This is a recipe for a time-
consuming formatting effort.

A scenario like that can be prevented by
instructing each contributor to start from
the same template. This is especially easy if
all of the contributors have access to a
shared drive on a network. Word refers to
templates accessed this way as Workgroup
templates. There is some preparation in-
volved, but it’s simple and only takes a few
minutes:

1. Create a directory on the network for
the shared template(s). Figure 1 on
page 4 shows a directory called MS
Word Templates, and under it is an-
other directory called Workgroup.

2. Copy the template(s) to the Workgroup
directory.

3. Change the Workgroup template file
location in Word. This is a one-time
operation that each template user will
need to do:

a. Choose Tools > Options from the main
menu.

b. Click the File Locations tab.

c. Select Workgroup templates.

(Continued on page 4)
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WWWWWord Smith: Tord Smith: Tord Smith: Tord Smith: Tord Smith: Tooling Around with Tooling Around with Tooling Around with Tooling Around with Tooling Around with Templatesemplatesemplatesemplatesemplates

d. Click Modify.

e. Navigate to the Workgroup directory.

f. Click OK until the dialog boxes are
closed.

Once Word has been configured, the con-
tributing authors can choose File > New,
click the Workgroup Templates tab, and
select the appropriate template.

Another way to tell Word where to look for
shared templates is with the following short-
cut.

        1. Start Word.

2. Choose Tools > Options from the
main menu.

3. Click the File Locations tab, and
note the Location shown for User
Templates. You will need this path
for step 5.  (You may have to click
the Modify button in order to see
the full path.)

4. Close the dialog box, and close
Word.

5. Start Windows Explorer—or other
file management program—and
navigate to the Workgroup direc-
tory.

6. Right-click on the Workgroup di-
rectory icon and choose Create
Shortcut from the pop-up menu.
A link file is created called “Short-
cut to Workgroup.lnk.”  See Fig-
ure 1.

7. Copy (not move!) the “Shortcut
to Workgroup.lnk” file to the User
Templates directory you noted in
step 3. See Figure 1.

8. Restart Word.

9. Choose File > New. If all is well,
you will see a “Shortcut to
Workgroup” tab among the other
tabs in the dialog box.

(Continued from page 3)

Bob Mohr is a senior member of STC
and a technical writer at BillingZone,
LLC. He can be reached via e-mail at
bob.mohr@billingzone.com.��

Figure 1:  Location of User Templates (left); Workgroup Templates (right) on a network drive

NOTE: You should change the
properties on the template files
to “read-only” and make sure
you are the owner of the files,

so that they aren’t accidentally
changed or deleted.
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personal identification number, and you’re
connected! You then sit back and listen to
the presentations and join in the lively Q&A
sessions.

STSTSTSTSTC groups warming up in the ‘BurghC groups warming up in the ‘BurghC groups warming up in the ‘BurghC groups warming up in the ‘BurghC groups warming up in the ‘Burgh

Two special interest groups are planning
March meetings. The Pittsburgh Frame
Users Network (FUN) is meeting on March
13, 2001 from 1:00 – 4:00 at the Sheraton
Station Square Hotel.

The meeting will feature XML: Publishing
Redefined, a presentation of the capabili-
ties of  XML publishing and how FrameMaker
can  support  your organization’s XML pub-
lishing needs. The meeting is sponsored
by Kay Ethier of Bright Path Solutions.

There is no fee to attend the meeting, but
registration is required. To register, or to
get  m o r e  i n f o r m a t i o n ,  v i s i t  h t t p : /
w w w. t r a v e l t h e p a t h . c o m / H T M L /
xmlevent.shtml, or call Bright Path Solutions
at 919-547-0129.

After a brief hiatus, the Pittsburgh STC
Consultants and Independent Contractors
(CICS) Special Interest Group is resuming
regular meetings.

All freelancers, independent contractors,
and consultants (and those who are con-
sidering the independent lifestyle) are in-
vited to attend. The CICS SIG will meet at
6:00 p.m. on Thursday, March 15 at the
Church Brew Works, 3525 Liberty Avenue,
in Pittsburgh’s Lawrenceville neighbor-
hood.

The Pittsburgh STC Chapter will provide
light refreshments. If you plan to attend,
please RSVP to CICS SIG coordinator Alan
Houser, arh@groupwellesley.com, 412-363-
3481.

...And so will the Consultants SIG...And so will the Consultants SIG...And so will the Consultants SIG...And so will the Consultants SIG...And so will the Consultants SIGFFFFFrame Users SIG to meet in March...rame Users SIG to meet in March...rame Users SIG to meet in March...rame Users SIG to meet in March...rame Users SIG to meet in March...

�

PPPPPeople Newseople Newseople Newseople Newseople News

LLLLLorelei Dorelei Dorelei Dorelei Dorelei D. L. L. L. L. Lairdairdairdairdaird
Jessica Jean MailkiJessica Jean MailkiJessica Jean MailkiJessica Jean MailkiJessica Jean Mailki
Lisa A. OverLisa A. OverLisa A. OverLisa A. OverLisa A. Over
Natasha A. ShertzerNatasha A. ShertzerNatasha A. ShertzerNatasha A. ShertzerNatasha A. Shertzer

Chapter MembershipChapter MembershipChapter MembershipChapter MembershipChapter Membership:::::
219219219219219

TTTTToooootttttal Sal Sal Sal Sal STTTTTC MemberC MemberC MemberC MemberC Membership:ship:ship:ship:ship:

24,46824,46824,46824,46824,468

New Members:New Members:New Members:New Members:New Members:

                           Hideki Kamita  Hideki Kamita  Hideki Kamita  Hideki Kamita  Hideki Kamita

Managing Documentation with HumorManaging Documentation with HumorManaging Documentation with HumorManaging Documentation with HumorManaging Documentation with Humor
and Grace: An STand Grace: An STand Grace: An STand Grace: An STand Grace: An STC TC TC TC TC Telephone Seminarelephone Seminarelephone Seminarelephone Seminarelephone Seminar
Managing the people and projects associated with technical documentation gets more
difficult every day. Coping with changes in technology, blending teams after mergers and
acquisitions, facing layoffs, finding qualified candidates, meeting ever-changing dead-
lines and requirements—these are just some of the challenges technical communication
managers and team leaders face. This telephone seminar will give you practical tips and
techniques that you can use to help keep your sanity while those around you seem to be
losing theirs—as well as a greater appreciation for all the good things about technical
documentation that led you to the field in the first place.  Doreen A. Mannion, an award-
winning author, frequent STC conference speaker, and project manager at McDonald
Bradley Inc., will conduct the seminar.

The objectives of this seminar include the following:

• To develop methods to promote your department
• To discover your professional passion
• To understand the real reason subject matter experts are not more cooperative
• To appreciate the role of humor in ensuring your success
• To learn a sure-fire way of helping co-workers appreciate the challenges of being a
technical communicator
• To understand how respect and credibility are earned, not awarded

You will also take away two complete Powerpoint presentations supporting the objectives
of this seminar that you can tailor and offer to your colleagues at the office.

What is a TWhat is a TWhat is a TWhat is a TWhat is a Telephone Seminar?elephone Seminar?elephone Seminar?elephone Seminar?elephone Seminar?

A telephone seminar is much like a large
conference call—but in a more controlled,
radio-like environment. You simply dial the
800 number from your phone, enter your

Society for TSociety for TSociety for TSociety for TSociety for Technical Communicationechnical Communicationechnical Communicationechnical Communicationechnical Communication

Pittsburgh ChapterPittsburgh ChapterPittsburgh ChapterPittsburgh ChapterPittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Heather Lum
Phone: 412-243-3151

hlum@pobox.com

National OfficeNational OfficeNational OfficeNational OfficeNational Office
901 North Stuart Street
Suite 904
Arlington, VA 22203-1822
Phone: 703-522-4114

Fax: 703-522-2075

(Continued on page 8)
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Ames wants your voteAmes wants your voteAmes wants your voteAmes wants your voteAmes wants your vote

TechComm
Technical Writing

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508

Telefax: 412-531-4796

blieberman2@compuserve.com

Dr.  Karen Schnakenberg
Director, MAPW Program

krs@andrew.cmu.edu
412.268.2659

For  more information, or to
attend a free, one-day

information design
workshop,contact

Carnegie Mellon

M.A.  Professional

• Technical  Writing

• Professional Writing

• Document Design

• Online Information

Writing

15  month program
Financial aid available

Design

(manuals, help, etc.) we deliver—nor the
tools we use to develop them. Instead, our
employers will recognize the value we bring
to the products and information we design
and develop. Think about it: The real value
we bring is not the documents we develop
but the user’s increased success! My goal
is to work to help the organizations in and
with which we work understand this and
help enable them to get the most value from
us.

As I’ve traveled around the country speak-
ing with members, I’ve met many of you
who share this vision. From my 17 years of
experience in the industry, my vast network
of associates, and the strategic work I’ve
done with various kinds of organizations,
I’m convinced that this is the right vision.
The question remains: How will it happen?

The implementationThe implementationThe implementationThe implementationThe implementation

The move toward this vision has already
begun—primarily via STC. As our new mis-
sion statement proclaims, we are certainly
“designing the future of technical commu-
nication.” STC is one of the most valuable
and powerful tools we have, and our work
in STC is one of the most important contri-
butions we can make to our own careers.
The power of many, the visibility of a large
and well-respected professional organiza-
tion, and vision and leadership are the in-
gredients that will change the face of our
industry.

To do this, I want to work with the Society
as I have during my 14-year STC career to
enable members of our industry to become
leaders and to be recognized for that lead-
ership—particularly within our organiza-
tions and among our employers’ and cli-
ents’ industries. Working with the Board of
Directors, committee managers, and chap-
ter leaders, I can support and maintain im-
portant programs—like branding and gov-
ernance—that are already working to move
us in this direction. I can also work with

other leaders to devise new initiatives to
raise the visibility of STC and our industry,
as well as help our employers and clients
further recognize our value.

Not one to sit around and wait for someone
else to take the lead, I’ve spent most of the
past four to five years changing our indus-
try to fit my vision. In my own career, I have
focused on learning and developing skills,
technologies, and tools to design and de-
velop information for products and user
experiences, rather than documentation
deliverables. I am a technical communica-
tor specializing in audience analysis, infor-
mation and interaction design for product
user interfaces and online assistance, us-
ability, and user-centered product and in-
formation design and development pro-
cess.

To assist others in the effort to move to-
ward the future, I’ve acted as a mentor,
teacher, and educational certificate coordi-
nator to:

* Design programs and courses around
these skills and technologies

* Impart to my students strategies and prob-
lem-solving skills so that they can partici-
pate in this new world

* Guide those asking for assistance to de-
velop their careers in similar directions

The larger perspectiveThe larger perspectiveThe larger perspectiveThe larger perspectiveThe larger perspective

I’ve spoken at many STC chapter meetings,
regional conferences, and annual confer-
ences, and met many of you—the members
of our industry. My presentations are aimed
toward helping you make career develop-
ment choices that increase your value to
the industry and to your employers and cli-
ents. I’ve encouraged you to:

* Think outside the traditional documenta-
tion box

* Evangelize usability and user-centered
design and development techniques within
your organization

(Continued on page 7)

(Continued from page 1)
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Ames wants your voteAmes wants your voteAmes wants your voteAmes wants your voteAmes wants your vote

* Participate in your organization’s design
and development process at a strategic
level

I’ve used my term as Director-Sponsor, and
my year as Society Bylaws Committee Man-
ager, to learn as much about you and the
Society as possible. Understanding how our
organization works enables me to influence
STC’s direction and effect change. I’ve also
participated very actively in two very im-
portant Society initiatives: Integrated
branding and Governance.

The results of these programs are already
permeating the Society and changing the
way we do business. From the Board of
Directors to the Society Office to Society-
level committees to chapters to members,
everyone will feel the impact of these very
positive changes.

I’ve also served the Society extensively in
other international-level positions and at

the regional, local, and chapter levels. De-
tails follow in “ANDREA’S STC AWARDS
AND SERVICE” and are posted at
w w w . v e r b a l - i m a g e r y . c o m /
PositionStatement.pdf.

And although I’ve spent a lot of time talk-
ing to members of the profession, I draw
from extensive experience of my own in the
corporate world, academia, and govern-
ment—both as a direct employee and as a
consultant.

Biographical informationBiographical informationBiographical informationBiographical informationBiographical information

ANDREA L. AMES, M.S., is a technical
communicator specializing in audience
analysis, information and interaction design
for product user interfaces and online help
systems, usability, and user-centered prod-
uct and information design and develop-
ment process.

She has 17 years’ experience designing,
developing, and producing usable techni-
cal and scientific information for products,

software user interfaces, multimedia and
online-help systems, and print documenta-
tion. Ms. Ames is the owner of Ucentrics, a
user-centered information and interaction
design and usability consulting company.
She is also a principal technical writer at
Vertical Networks, where she designs in-
formation and interaction for product user
interfaces, as well as embedded user assis-
tance and custom help systems.

She is a member of the Society for Techni-
cal Communication (STC) international
board of directors in her position as direc-
tor-sponsor of STC’s Region 8; a junior fel-
low of the San Diego Supercomputer Cen-
ter (SDSC); and a published author and
freelance writer.

She teaches at the university level, speaks
internationally at professional conferences,
and presents seminars and workshops on
audience analysis, information and interac-
tion design, usability, and user-centered
process topics.

TTTTTeich wants your vote, tooeich wants your vote, tooeich wants your vote, tooeich wants your vote, tooeich wants your vote, too

for the Carnegie Museum of Natural His-
tory in Pittsburgh. There I developed co-
operative programs mainly for adults, try-
ing to make complicated environmental sub-
jects understandable and interesting so that
people would be willing to take action. I
didn’t call it technical communication at the
time, but that’s what was going on.

In 1980, I moved back to Ohio, to Cincin-
nati, and have worked here for government
agencies, private industry, and as an inde-
pendent, in technical communications con-
cerning everything from water pollution
control to plastic processing methods, from
pharmaceutical market research to ERP soft-
ware.

I also teach technical marketing communi-
cations in a local technical college program.
My decision to “go independent” was a
long time in the making, but my being

downsized in late 1995 was a significant
shove in that direction.

I’ve been a member of STC since 1988. I’ve
been director-sponsor of Region 4, public
relations manager for the 1999 annual con-
ference, and a member of the academe-in-
dustry committee.

I’ve presented at many annual and regional
conferences on starting your own business,
professional development, and marketing
communications.

For the Southwestern Ohio chapter (SWO),
I was president, vice president, and compe-
titions manager (for three years). I also
served on the 1997 Region 4 conference
committee and the SWO professional de-
velopment committee.

I regularly judge local STC competitions,
have judged international competitions, and

(Continued on page 8)
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have won publications awards. I’m also a
member and past officer of some other local
communications organizations.

WWWWWhat do I bring to the table?hat do I bring to the table?hat do I bring to the table?hat do I bring to the table?hat do I bring to the table?

First, I bring a “can-do,” implementation-
focused orientation. Moving ideas and
plans from “ought” to “action” is one of
my strengths. Determining the optimal way,
which may not necessarily be the fastest or
the cheapest way, to transform projects from
plans to production—and then doing it—
is how I’ve earned my living for many years.

Second, I believe that to make good deci-
sions, input from people who don’t think
exactly as I do or who have different priori-
ties is necessary. I listen. I believe consen-
sus leads to decisions that respond best to
the issues.

Third, I bring a breadth of experience to the
office. Technical communicators work in
varied situations—and I’ve been through
most of them. Independent, corporate, non-
profit, educational, downsized, upsized,
overwhelmed—I’ve been there. As a result,
I think I have more than an inkling of what
many STC members face every day.

Fourth, and perhaps most important, my aim
is to use the talent and capabilities we have
as an organization to foresee the trends in
our profession so we can plan for them and
better help STC members meet the needs
and opportunities presented by those
trends.

Our profession’s value to the world at large
is being increasingly recognized. Part of the
reason for that is the times we live in.

But another part of the reason is that we
have a professional organization that rep-
resents us as a body; we are no longer an
amorphous conglomeration of easily re-
placed “support services.” Over much of
the past almost 50 years of STC’s existence,

the focus has been on promoting our pro-
fessionalism, supporting educational pro-
grams and research, improving, and—let’s
face it—helping to stabilize—our places and
value in corporate and other entities.

Designing—and drawing, paint ingDesigning—and drawing, paint ingDesigning—and drawing, paint ingDesigning—and drawing, paint ingDesigning—and drawing, paint ing

and, framing—our futuresand, framing—our futuresand, framing—our futuresand, framing—our futuresand, framing—our futures

Now that we’ve determined “to design the
future of technical communications” (our
new mission statement), my goals involve
focusing our efforts on the professional
development of our members so they can
answer the classic job interview question,
“where do you want to be in five years?”

By exploring trends and possibilities now
and helping members prepare for them, we
can work toward—instead of merely re-
spond to—what will happen five years from
now. We can truly “design the future of
technical communication.”

In other words, we can design, draw, paint,
and frame our own futures.

I also want to promote both the profession
and the organization so that technical com-
municators view STC the way medical
doctors view their associations and engi-
neers view their societies—as essential el-
ements of their professions. Our branding
effort was a springboard: Let’s put what we
learned about ourselves to work.

In the meantime, please remember to vote
in the upcoming STC elections. You can do
so either on the traditional paper ballot or
electronically at the STC Web site this year.

I hope you’ll vote for me for 2nd vice presi-
dent. But the important thing is to vote.
You’re a member of this group. Here’s your
chance to help design STC—as well as the
future of technical communication.

For more information about me, please visit
my Web site, www.TeichTMC.com. You may
also contact me at Thea@TeichTMC.com.
Thank you for your time and attention.

Editor’s Note: Teich gave a presentation
on starting your own business at the Feb-
ruary meeting of the Pittsburgh STC. A
summary of her presentation appears on
Page 9.

(Continued from page 7)
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When?When?When?When?When?

Wednesday, April 18, 2001
1:00–2:30 PM Eastern Standard Time

BenefitsBenefitsBenefitsBenefitsBenefits

• No travel time
• Pay per site and not per person
• Opportunity to train all your people
without anyone leaving the office

CostCostCostCostCost

With a telephone seminar, the cost is per
site, not per person.

U.S. sites: $125.00
Canadian sites: $140.00
Overseas sites: Please contact the STC
office

An additional $8.00 will be charged for reg-
istrations received less than five days be-
fore the seminar.

The cost of the telephone seminar is per
participating site, not per person.

Train as many people as your conference
room can hold — for one flat rate!

About the SpeakerAbout the SpeakerAbout the SpeakerAbout the SpeakerAbout the Speaker

Doreen A. Mannion, a senior member of
STC, has been a professional communica-
tor for over fifteen years. She is also an
award-winning author, a frequent speaker
at STC’s annual conferences, and the Man-
agement and Professional Development
stem manager for STC’s 48th Annual Con-
ference, May 13–16, 2001, in Chicago, Illi-
nois.

Doreen has worked as a stand-up comedi-
enne, advertising salesperson, trade show
coordinator, technical editor, technical
writer, indexer, insurance agent, sports talk
show host, and football official. She is cur-
rently a project manager at McDonald Bra-
dley, Inc., in McLean, Virginia.  McDonald
Bradley consultants provide complete life
cycle information technology to federal
government and commercial clients.

Phone SeminarPhone SeminarPhone SeminarPhone SeminarPhone Seminar
(Continued from page 5)
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ness cards everywhere.  Make periodic ca-
sual contact with past clients. Perhaps place
targeted ads.

4.   Finances.  You should have 6 to 12
months of “life support” capital in the bank
before you start.  It often takes 30 to 60
days to get a check.  Remember that half of
your earnings go toward taxes.  Set up a
separate business account. Be sure to esti-
mate and pay quarterly taxes.  Know what
deductions you can take and what forms
you must file.  You can set up an IRA and
an SEP (pension for self employed).  Send
invoices, and keep records of all invoices
and payments; do not rely on getting a 1099
from a client.

5.   Contracts.  Contracts can be various
levels of formality from verbal to letters of
agreement to formal signed documents.  Le-
gally, unless the contract states otherwise,
you own the work you write.  However, you
usually cannot “take it to the bank.”

6.   Managing Time.  A consultant’s day is
24 hours, not 8.  This provides a lot of con-
tradictions.  You must have a routine, but
be flexible.  Deadlines rule you, but they
must be reasonable.  Know your limits.

7.   Isolation.  Prevent isolation.  Join STC!
Take advantage of support services and
outlets.  Don’t tie up the telephone.

8.   Personality.  You must be comfortable
with people, with juggling work, with switch-
ing gears to new topics, with learning, with
the unknown.  And you must be disciplined.

9.   Development.  Budget for learning. How-
ever, you will not be able to deduct the en-
tire cost of courses and seminars.  The cli-
ent does not expect expertise. They will ex-
plain things to you.  But the more you know
about your tools, and your major areas of
work, the better.

— Compiled by Chapter Secretary Nancy
Carpenter

Going Independent: A presentation by Thea TGoing Independent: A presentation by Thea TGoing Independent: A presentation by Thea TGoing Independent: A presentation by Thea TGoing Independent: A presentation by Thea Teicheicheicheicheich
Presented by Thea Teich at the Feb. 21
meeting of the Pittsburgh STC chapter.

In a fast-paced talk, Thea outlined an excel-
lent approach to going independent.

Before you take the plunge, please answer
the following questions:

1.   What profession do you want to fol-
low?  There are many variations on the
theme of technical communication.

2.   Do you have a network?  It is extraordi-
narily difficult to go into consulting with-
out the help of others.

3.   Can you deal effectively with people,
face-to-face?  Direct contact is the norm.

4.   Do you have a good accountant? It’s
time consuming to find and do the work.

5.   Do you have the hardware/software you
need?  Buy it as you need it, rather than
stock up.

�

Important IssuesImportant IssuesImportant IssuesImportant IssuesImportant Issues

Of the following issues, many consultants
find No. 1, 3, and 7 to be the biggest.

1.   Charge rates.  Don’t be afraid to ask
other writers in the region what they rec-
ommend.  And do not undervalue yourself.
Thea found that a flat rate was best for all
types of work, since the client was hiring
her services, no matter what the project.
Some clients will set a rate.  Half of your
earnings go toward taxes, so set a rate that
can support you.  If you want to provide a
discount, reduce your hours, not your rate.

2.   Network.  Establish a network of con-
sultants who can provide special services
such as graphics, printing, accounting, le-
gal services, proofreading, and subcon-
tracting of an entire job.

3.   Clients. Most of your work will come
from referrals.  Ask everyone you know if
they need writing services or know anyone
who needs writing services.  Take your busi-
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March, 2001March, 2001March, 2001March, 2001March, 2001

March Meeting: RMarch Meeting: RMarch Meeting: RMarch Meeting: RMarch Meeting: Region 2 Directoregion 2 Directoregion 2 Directoregion 2 Directoregion 2 Director-----Sponsor to Speak atSponsor to Speak atSponsor to Speak atSponsor to Speak atSponsor to Speak at
Chapter Awards BanquetChapter Awards BanquetChapter Awards BanquetChapter Awards BanquetChapter Awards Banquet

Coming Up: STComing Up: STComing Up: STComing Up: STComing Up: STC AC AC AC AC Awards Banquetwards Banquetwards Banquetwards Banquetwards Banquet

“Getting in the Loop: How Information
Developers Can Support the Entire Prod-
uct Development Cycle”

Presented by Chris Benz, STC Region
2 Director-Sponsor.

Get ready for the STC Pittsburgh chapter’s
2001 Awards Banquet, featuring STC Re-
gion 2 Director-Sponsor Chris Benz as our
guest speaker!  Chris is Operations Direc-
tor of e-Publishing in Research Triangle
Park, NC, which is a national information
design and development company. The
topic of his presentation should be of inter-
est to any technical writer who could use
some advice and suggestions on how to
make more of a difference in the projects
they support.

This meeting/dinner is your chance to honor
chapter members who have received recog-
nition for the quality of their work. The
awards event will be hosted by our favorite
banquet emcee, John Clark. Entries will be
on display, providing an excellent opportu-

WHEN: Thursday, March 22. 2001,
5:30-7:00pm dinner; 7:00-9:00pm
program

WHERE: Duranti’s Restaurant, 128
North Craig Street. Free parking is
located behind the restaurant, off
of North Neville Street.

COST: $17

NOTE: There is no option to attend
the meeting WITHOUT paying for
dinner, and you MUST pay Darlene
in advance.

RSVP: March 20, 2001, Noon, to
Darlene Mullenix, Meeting Coor-
d i n a t o r ,  ( 4 1 2 )  2 8 8 - 8 6 7 6 ,
dmullenix@federatedinv.com.

Make checks payable to STC-
Pittsburgh and mail to: STC-Pitts-
burgh, P.O. Box 33, Pittsburgh, PA
15219, ATTN: Darlene

nity to see what your colleagues have been
doing with their time! Each award winner
from our chapter competition will be invited
to describe their work and what went into
creating an award-winning product.

Menu:

Choose 1 of the following entrees when you
RSVP to Darlene:

  Italian Chicken Breast with Ricotta and
Spinach

  Grilled Filet Mignon Brushed with Steak
Butter

  Eggplant Parmigiana with Marinara and
Cheese

Dinner also includes: Wedding Soup,
Tossed Green Salad, Oven Browned Pota-
toes, Rolls and Butter, and Choice of 1 Des-
sert (Ice cream, Sherbert, Chocolate pud-
ding, or Peach cobbler).

Dinner is $17, and you must pay ahead of
time. There is NO meeting-only option.You
must attend both dinner and the meeting.�


